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Please see the main HyperSnap-DX 4 help file, this file is only for providing context-sensitive
help, and should be opened only by the program itself.
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i@ Multi-region capture
One of HyperSnap-DX 4's most powerful features, this function allows you to define multiple regions
using its built-in tools for this (they can be of several shapes and formats) and then capture them. The
space "between" the regions will be filled by the color you select on the Capture tab in the Capture
settings tabs (see below).

You should see the {button Capture menu help,JI("hprsnap4.hip","idh_capture_menu_help")} for exact
directions on how to use this complex and powerful feature.

You may wish to read the {button Capture settings help,JI("hprsnap4.hlp","IDH_capture settings_tabs")}
section to read more about settings that affect how the capture functions work before proceeding.
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i@ Capture settings
This opens up the options tabs for setting important properties of the capture functions. Be sure to read
the help for each tab (press the Help button on each) prior to changing any of the default values.

TIP
«& The first tab, the Capture tab, contains the features you will probably adjust most frequently.
Click here to read the {button Capture settings help,JI("hprsnap4.hlp","IDH_capture_settings tabs")}.
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i@ Drawing tools
This toggles the drawing tool palette on and off. If you aren't going to draw on an image, you can

conserve screen real estate by hiding the drawing palette.
Click on {button View menu,JI("hprsnap4.hlp","IDH_view _menu_help")} to read more about other items
on this menu.
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i@ Paste as new image
This function pastes the clipboard contents as a completely new image (rather as appearing over the
currently-open file). If you've changed---but not saved---the current image, you'll be prompted to save
your changes before the paste takes place.

For more help about the Edit menu, see the {button Edit menu
help,JI("hprsnap4.hlp","idh_edit_menu_help")}
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i@ Set as wallpaper
This function sets the current image displayed in the HyperSnap-DX 4 window as your Windows

wallpaper. The image must be converted to the correct format and your current wallpaper file setting will
be changed to reflect the new setting.

You'll also be given the options for displaying the wallpaper centered, tiled, or stretched to fit your current
desktop's resolution.

oty
i@ If your video driver has an option for displaying in colors greater than 256, and you haven't enabled
this already, you might want to try it. Most images will look far better if you can display greater color depth.
A good starting point is at least 32,000 colors, which virtually all modern video boards can now do, and 24
bit color (although a bit slower on less-powerful machines) is even better, insuring that your wallpaper will
always look great.

For more help about the File menu, see the {button File menu

help,JI("hprsnap4.hip","idh_file_menu_help")} section.
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i@ Gamma

This function allows you to adjust the white content of your image. You can "brighten up" dim images or
images that appear overly "dense" by using this function. It will bring out details in the shadows as long as
there is some information in the darker areas. You can also darken-down overly washed-out images with
this function by adjusting for a lower gamma level.

Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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i@ Halftone

This function converts the image to a halftone image, similar in nature to how a newspaper prints a
photograph. A "screen" angle needs to be applied to the image, and this setting will affect how the image
will appear. You may need to adjust the "screen" angle and attempt several tries to get the exact result
you wish. The simpler the original image is, generally the better it will halftone. Images with lots of line

content typically halftone poorly.
Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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i@ Black and white

This function converts the image to a monochromatic black and white image. You can adjust how dark or
light you wish the product to be by dragging a slider back and forth. To see the adjustment appear on your
image, choose Apply. Close to keep the change, Cancel to abort.

Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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Grayscale
This function converts the image to something like a black and white photograph. It removes color data,

but keeps luminance values.
Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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i@ Color resolution
This function allows you to adjust the total numbers of colors in the current image as well as set dithering
options when you reduce colors. Dithering causes the program to try to approximate the removed colors
by altering the colors of adjacent pixels to more closely resemble the original image, but at what appears
to be a lesser resolution (sort of like how newspapers handle color photographs).

Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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Brightness
You can adjust the brightness of your image (just like how you adjust the brightess on a TV) by using the
controls here. Select a percentage to increase from the original, from no change to a 100% increase, or
from no change to a -100% decrease. Working with Gamma and Contrast, you can use this to get

washed-out or overly-dense images back into usability.

Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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i@ Contrast

This function works exactly like the same-named control on your color television set. You can adjust the
"knee" of the image to that it represents a greater or lesser range of contrast values. The effect here will
be to "block up" the image (more contrast between dark and light areas) or "flatten out" the image (less
contrast between dark and light areas). Combined with Gamma and Brightness, you can correct faded,
flat, or blocked-up images with these functions.

Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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Hue

This function works like the Hue control on your television. You can adjust the color "bias" of your image
with the controls here. The degrees represent the angle on the "color wheel," where all possible colors

are represented on a wheel like the hours on a clock. By pointing at a certain degree, you bias the color
balance of the image using the color located at that position on the wheel.

e
i@ Note that 1, 0, 360 and -360 represent the same position, just gotten to by different directions of
rotation, so there is essentially no change in your image. If you have 360 degrees of rotation, and you
rotate backwards 360 degrees from your original position (which is defined as 1 or 0) then you haven't
really moved anywhere significant, you've just spun around in a circle and now you're facing the same
way.

Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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i@ Saturation

This function lets you adjust the degree of color that the image expresses. The saturation value is most
easily understood by thinking of your television again. It's like the knob usually marked, "color." Turn it up
and you get more color. Turn it down and you get less. All the way down and you get a grayscale image.

L
i@ If you think of Saturation as you would how "wet" a brush is when dipped in paint. The wetter it is,
the more intense is the color. The drier it is, the less intense is the color.

Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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i@ Invert black and white
This function reverses the black and white values of the image. It only changes areas that are either pure

white or pure black, and no other regions are affected unless they contain spots of either color.

Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items

on this menu.
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i@ Unique colors
This function counts the total number of unique colors in use in the image. If you need to reduce color
depth, this function will give you an idea on how far you can go before you seriously degrade the image.
For example, if your image is currently 24 bit but is only using 300 colors, you can probably reduce it
down to 256 (perhaps making the file much smaller) without serious degradation. But if it's using 32,000

colors, it may not reduce well to lower values.

e
i This is an informative function only, and doesn't act on the open image. It just provides data for you
to use during your operations.
Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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Invert colors

This function reverses the colors in the image. If your original image is a positive (like a slide or a printed
photograph) the result of using this will be a negative image. And if your original is a negative image (like
a scan from a film strip negative), the result will appear as the shot would when printed on photographic

paper.
Click on {button Color menu,JI("hprsnap4.hlp","idh_color_menu_help")} to read more about other items
on this menu.
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i@ Mirror horizontal
This function "flips" the image from left to right, as though it was seen in the reflection of a mirror.

Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other
image related functions.
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i@ Mirror vertical
This function "flips" the image from top to bottom, reversing the vertical contents of the image.

Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other
image related functions.



e
i@ Shear

This function "shears" the image, which will make it appear as though a vertical canvas has been rotated
"away" from you on a table surface. Examine the preview that will appear when you use this function to
see how it alters the image (making it appear to be extending into 3D space).

Choose Cancel after you've seen the preview to discard it.

e
i If your image is all one color (such as a new image with a white background) you won't be able to
see anything happen in this, and in other similar functions, for pretty obvious reasons!
Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other
image related functions..
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i@ Auto trim

This function attempts to trim off excess "blank" background canvas from your image, making it smaller.
The best method to use is to try the function and then immediately hit Edit / Undo if it doesn't trim the
image in the method you desired.

Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other
image related functions.



Kl
Mosaic
This function applies a special filter over the image to make it appear to be made from mosiac tiles.

Experiment with different tile sizes to see how the effect works. Smaller tiles keep more of the original
image's information, larger tiles replace more of it with tile borders and make it harder to identify.

Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other
image related functions.
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i@ Emboss

This function applies a special filter to the image to give it the appearance of embossed paper (or metal).
You can control the direction of the light (from which direction it originates and in which direction it shines)
as well as the depth of the embossing. The deeper an image is embossed, the more distortion will be

applied to the original data.
Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other
image related functions.
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i@ Credits

This will show a credits screen, as well as some copyright information.
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i@ Contents

This will load the main help file at the table of contents page.
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i@ Full screen

Use this to capture the entire Windows desktop. It's essentially the same as the unmodified Print Screen
function built into Windows. You can't select which window to grab, it simply takes "everything" visible.
Note that this will not capture a DirectX or other "special" screen, you'll need to use the {button Advanced
capture tools,JI("HPRSNAP4.HLP""IDH_GLIDE_CAPTURE")} for grabbing those types of screens.

You may also want to read about certain capture settings that affect how HyperSnap-DX 4 works, too, in
the section {button Capture settings help,JI("hprsnap4.hip","IDH_capture_settings_tabs")}.
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i@ Window, button, or control
This function will capture a restricted region, such as just the contents of a program's window, or a single
program control or button. Use this function when you want to capture just a small part of a running
application or Windows itself.
As you move the mouse over the area to be captured, the various parts of the applications open or the
system will "light up" showing you what is to be captured. Click the left mouse button to complete the
capture.
You may also want to read about certain capture settings that affect how HyperSnap-DX 4 works, too, in
the section {button Capture settings help,JI("hprsnap4.hlp","IDH_capture_settings_tabs")}.
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i@ Active window
This function captures the active (sometimes called "front") program window.

You may also want to read about certain capture settings that affect how HyperSnap-DX 4 works, too, in
the section {button Capture settings help,JI("hprsnap4.hip","IDH_capture_settings_tabs")} .
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i@ Active window without frame
This function captures just the "inside contents" of the active (sometimes called "front") program window.
If you only want to get the window's contents rather than its border, this is the function to use.

You may also want to read about certain capture settings that affect how HyperSnap-DX 4 works, too, in
the section {button Capture settings help,JI("hprsnap4.hip","IDH_capture_settings_tabs")} .
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Region
This function lets you capture a region you can define. It can encompass multiple windows, your desktop,

or virtually anything that's visible on your desktop. Unlike the Capture window or Capture desktop
functions, this function does not discriminate between the various windows on your screen.

iy
i This capture mode treats your entire desktop as a "canvas" from which you can pick a region to
save to HyperSnap-DX 4's workspace.

You may also want to read about certain capture settings that affect how HyperSnap-DX 4 works, too, in
the section {button Capture settings help,JI("hprsnap4.hlp","IDH_capture_settings_tabs")} .
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i@ Repeat last capture
This function repeats the last capture you performed, exactly as you performed it. This is a terrific way to
capturing the "in progress" screens of a running program. By selecting this over time or repeatedly
pressing its hot key, you can grab the same region, window, or control over and over.

You may also want to read about certain capture settings that affect how HyperSnap-DX 4 works, too, in
the section {button Capture settings help,JI("hprsnap4.hlp","IDH_capture_settings_tabs")} .
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i@ Enable special capture
One of the program's most powerful features, this function captures screens from DirectX, Glide, and
other 3dFX hardware. This type of capture has several complicated options that you should examine prior
to performing one. There are post-capture processing options, as well, that may need to be used to get
the best possible results.

You may also want to read about certain capture settings that affect how HyperSnap-DX 4 works, too, in
the section {button Capture settings help,JI("hprsnap4.hlp","IDH_capture_settings_tabs")} .

You should also read the section that covers this special type of capture, {button DirectX and
Glide,JI("hprsnap4.hlp","idh_glide_capture")} as well as the tutorial in {button DirectX and Glide

tutorial,JI("hprsnap4.hlp","idh_directx_or_glide _capture_tutorial")}.



-y
Kool CAPTURE_QCOPY



-y
i@ CAPTURE_QPRINT



-y
Kial CAPTURE_QSAVE



-y
i@ CAPTURE_AUTOSCROLL



-y
i@ CAPTURE_CURSOR



-y
i@ CAPTURE_RESTORE



§isl

Crop
This function allows you to mark out a region of the file and clip the file's contents so they include only the
defined region. Essentially this is like taking scissors to the picture and cutting off everything outside of

the rectangle you define. When you click this your tool will change to the cropping tool, which you then
draw across the image.

Click the left mouse button after dragging the box to the desired size to execute the crop, and the crop is
performed.

Click on {button Image menu,JI("hprsnap4.hlp","idh_image menu_help")} to read more about other items
related to image functions.
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Scale image
This function re-scales the image in HyperSnap-DX 4's workspace to the dimensions you choose. You
may re-scale it and keep its aspect ratio or you may alter each axis independantly, which will cause the
image to become distorted. After selecting this function a dialog will appear where you can choose a
percentage of original to scale, or you can change the direct pixel-based dimensions.

e
i@ In addition, you can drag a slider on the top of the dialog back and forth to scale the image smaller
or larger by clicking on it and then holding down the left mouse button as you drag it back and forth, or by
using the left and right arrow keys to move the slider in the desired direction.

Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other
items related to image functions.
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i@ Configure hot keys
If you want to change them from the default keys, you can alter all of HyperSnap-DX 4's important hot
keys from the dialog box that will appear. Simply choose a function, then click the button to the right of
that function to select another hot key combination.

Click on {button Options menu,JI("hprsnap4.hlp","idh_options_menu_help")} to read more about other
items on this menu.
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i@ Startup and tray icon

These functions allow you to change how HyperSnap-DX 4 shows its icon (either on the task bar or in the
system tray area). You can also set the program to start automatically with Windows, making its handling
of the clipboard "a part of" the operating system the entire time you're using it.

Click on {button Options menu,JI("hprsnap4.hlp","idh_options_menu_help")} to read more about other
items on this menu.
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i@ Full screen

Clicking this will give you a total-screen view of your image. If the image is larger than your available
desktop, scrollbars will appear on the bottom and right hand sides, letting you see all of the image while in
preview mode. Press ESC (or almost any key) to cancel the full screen view. Use the mouse to drag the

scroll elevator buttons up and down or left and right to view the entire image.

Click on {button View menu,JI("hprsnap4.hip","IDH_view _menu_help")} to read more about other items
on this menu.
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Previous file

Loads the previous file in the current directory into HyperSnap-DX 4's workspace. This function (with the
Next file function) gives you a quick way of jumping back and forth to examine files within a directory.

In a way, these two tools are like a big-window "preview" function, letting you quickly see the files within
even a very large directory by hitting Pagedown and Pageup to go forward and backward, respectively.

Click on {button View menu,JI("hprsnap4.hlp","IDH_view _menu_help")} to read more about other items
on this menu.
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i@ Next file

Loads the next file in the current directory into HyperSnap-DX 4's workspace. This function (with the
Previous file function) gives you a quick way of jumping back and forth to examine files within a directory.

In a way, these two tools are like a big-window "preview" tool, letting you quickly see the files within even
a very large directory by hitting Pagedown and Pageup to go forward and backward, respectively.

Click on {button View menu,JI("hprsnap4.hlp”,"IDH_view_menu_help")} to read more about other
items on this menu.
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Acquire
If you have an image scanning device connected to your system, you can use it to import a scan of hard

copy into HyperSnap-DX 4's workspace. If you've not already done so, you must first select the source for
HyperSnap-DX 4 to use, with the Select source function on the File menu.

For more help about the File menu, see the {button File menu
help,JI("hprsnap4.hlp","idh_file_menu_help")} section.



T
i@ Select source
Use this function to choose from the available scanning sources on your system. If you have more than
one you'll see a list of compatible devices for which drivers are installed. Choose the one you wish to use
to scan hard copy and click Select.

iy
i@ Some devices often install multiple methods of scanning, for example HP Scanners often put in
their own proprietary scanning software and other programs may install their own software (such as Corel
Scan) that uses the HP device driver, but not the HP software. How well these products will work with
HyperSnap-DX 4 may vary. Typically the scanning software provided by the manufacturer works best.

For more help about the File menu, see the {button File menu

help,JI("hprsnap4.hlp","idh_file_menu_help")} section.
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i@ Rotate

This function rotates the image as if you were spinning a painting on a flat table. Because the image will
no longer be rectilinear when you rotate it, the empty areas that will appear in order to keep the image
rectilinear will be filled with the background color you set in the {button Capture
settings,JI("hprsnap4.hip","idh_capture_settings_tabs")} tabs.

Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other
items on this menu.
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i@ Default image resolution
This function lets you alter the default dot per inch resolution of the new images HyperSnap-DX 4
captures. If you'd prefer a resolution that differs from the default the program uses after installation (96
dpi, best for SVGA or higher screens) you can change that here and make the setting permanent. If you
find yourself repeatedly upping or lowering DPI resolution in your work, and always to the same value,
setting it here can save you some steps.

Click on {button Options menu,JI("hprsnap4.hlp","idh_options_menu_help")} to read more about other
items on this menu.
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i@ Change resolution
This function is different from simply "resizing" an image. This function changes the value of the dots per
inch specification, which will then make it appear different sizes on devices that operate at varying
resolutions. For example if a printer prints at 600 dots per inch and you change an image that is 1 inch
square to 300 dots per inch, it will print at a size of 1/2 inch (given certain printer settings being true). This
is comprehensive help on the dialog that appears, too.

Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other
items related to image functions.
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i@ Virtual desktop
This function can capture the entire windows desktop, even from systems with multiple monitors, or those
using video drivers that let them have "pan-able" desktops that go out of view (on any axis).

e
i{; Users with such multi-desktop systems will find that the Full screen function only will capture the
active region. If they wish to get the entire desktop (including areas not currently visible without scrolling
or moving the mouse, or looking at another monitor) they'll need to use this function.

You may wish to read the {button Capture settings help,JI("hprsnap4.hlp","IDH_capture settings_tabs")}
section to read more about settings that affect how the capture functions work before proceeding.



T
i@ Pan last region
This function captures the same region size as the previous Region capture, but allows it from any area of
the screen. In effect, it's like taking your defined region box and allowing you to "slide" it around the
screen to choose another same-size area. If you're fitting captures into specific-sized frames in a
document (for example) this technique will make that extremely easy, as each capture will be the exact
same proportions as the previous region capture.

You may wish to read the {button Capture settings help,JI("hprsnap4.hip","IDH_capture settings_tabs")}
section to read more about settings that affect how the capture functions work before proceeding.
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i@ Save options
Click this button to save the current options as the default options. Your preferences for the controls here
will be established in HyperSnap-DX 4's registry.
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i@ Select an item
You've pressed F1 with a menu open, but with no item on the menu selected, or with a top level menu
item open that has a child menu. Select a main menu item or a child menu item with the mouse if you
pressed the "get help" toolbar button, or with the arrow keys if you pressed F1 to see help for that item.
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i@ HyperSnap-DX 4 Hot keys
Click on the button to the right of the hot key that you wish to change. A dialog will appear, and within that
dialog you can hit the hot key that you wish to assign to that function. It should not be a key used by any
other Windows function, or other functions within HyperSnap-DX 4. Click on OK, return to the HyperSnap-
DX 4 Hot key dialog, and change any other function keys you want to re-assign.

On the check boxes below, you can choose to have HyperSnap-DX 4 capture the standard Windows hot
keys for capturing (Print screen is one), and then if the program is set to load with Windows (see the
{button Option menu help,JI("hprsnap4.hlp","idh_option_menu_help")} for Startup and tray icon) it will,
more or less, just become, "part of Windows."

The final check box is to enable or disable Hot keys, which if disabled means you must execute captures
via the HyperSnap-DX 4 menu rather than the applicable hot key. If any of the default hot keys (or all of
them) conflict with other programs you are using, you can still achieve captures by disabling hot keys
while the "offending" programs are running.
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i@ Send as e-mail
You can tell Windows to send the current image (which you'll be asked to save if you have not) to another
party via E-mail.
e

Q Note that certain E-mail settings must be established for this function to work, mainly relating to
internal MAPI functions. If this menu item fails, your system may not have the correct E-mail components
installed. Sometimes installing Outlook Express (which comes with most Windows versions) will repair
this error.



-y
i@ CAPTURE_OPTS
// *** Capture/Capture Options



T
i@ Enable "special" captures
This enables special DirectX, Direct3D, and 3dfx Glide hardware captures. The options here allow you to
specify from which type of system (or hardware) you wish to capture (make sure it's the same as what the
software is using), as well as enabling certain post-capture processing to attempt corrections to difficult-
to-capture software or media playback technologies.

For comprehensive help on how to use this powerful HyperSnap-DX 4 feature, you should read the
section of the main help file, {button DirectX Direct3D or
Glide,JI("hprsnap4.hlp","IDH_directx_or_glide_capture_tutorial")} tutorial.
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i@ ADV_OVERLAY
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i@ Change resolution dialog
This box lets you change the resolution of an image. You should examine the main help file's help for this
as well as the text on the dialog itself before changing this value. Note that displays and printers almost
always use different resolutions, making how a picture appears on your screen vary from how it will print
unless you take certain steps to control this.

Examine the main {button Image menu help,JI("hprsnap4.hlp","idh_image _menu_help")} section.
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i@ PRN_TEXTS
Il *** "File/Page Setup/Header and Footer"
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i@ REG_HLP1
// *** ignore all HIDD_REG_... symbols



T
i@ HKDLG

/I *** Hot key entry box, "Options/Configure Hot Keys" -
// then press any hot key button there.



T
i@ HOTKEYSETUP
/I *** Hot keys config, "Options/Configure Hot Keys" -



T
i@ START_TRAY
/I *** Options/Startup and Tray Icon
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i@ PIC_OPEN
Il *** File/Open



L=
i@ PIC_SAVE
/I *** File/Save As...



T
i@ PAGE_SETUP
/I *** File/Page Setup



-y
i@ REG_HLP2



-y
i@ REG_HLP3



-y
i@ REG_HLP4



T
i@ Quick save tab
This tab controls advanced options that let you automate "batch capture" sessions. The program will
automatically name files using a scheme you pick here (using a prefix and incremental numbering
process). This allows you to set up capturing, and repeatedly grab screens from rapid processes, making
quick, multiple captures not only possible, but relatively easy.

The default setting is to not save captures automatically to files (you normally would select Save as from
the file menu when you have a capture you wish to keep). But if you want to perform batch captures, the
features on this tab are extremely useful tools.

You can also repeat a specific capture procedure, allowing you to grab screens from processes where
you may want to show a progression over an exact time frame. You'll can use the (default) hot key
Shift+F11 to stop automated capturing processed once you're finished with them.

For detailed help on the Quick save tab, see the {button Quick save tab

help,JI("hprsnap4.hlp","idh_quick_save_tab")} section.



T
i@ Copy & print tab
You can set the program to copy each capture to the Windows system clipboard here, as well as
automatically paste each capture to a registered application on your system. If you check the option
Paste each capture to..., and then select a program from the available list, if that program is running
when you capture a screen, the data will also be sent to it via the clipboard.

Finally, you can check an option to have each capture printed automatically, too.

For more help on the Copy & Print tab see the {button Copy && Print tab
help,JI("hprsnap4.hlp","idh_copy print_tab")} section.



-y
i@ FILE_INFO

// *** Ignore the one below



-y
i@ Crop & scale tab

This tab controls whether or not and how captured images are sized once they've been grabbed from the
screen.

You can choose to crop out specific parts of the every image you capture (for example, always clipping
out part of a program's window rather than manually cropping it with each capture), or scale each
capture. Options include cropping by pixel values, or by matching the size of the rectangle in the
HyperSnap-DX 4 main window.

Scaling options can be by factor or by pixels, and can be equal for both horizontal, or different across the
two dimensions.

For detailed help on the Crop & scale tab, see the {button Crop && scale tab
help,JI("hprsnap4.hlp","IDH_crop_tab_example")} section.



B

Il *** File/Set as Wallpaper

-y
al set_wallpaper



-y
i@ CREDITS



§isl

Zoom

This tool lets you alter the view in HyperSnap-DX 4's workspace. If the image is larger than the program's
window, you can zoom out to view more (or perhaps even all) of it. If it's small and you wish to zoom in on
some detail, you can do that. You can use the Magnifying tool on the painting palette for zooming, as well.
Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Capture tab
This tab controls settings related to basic capture functionality. You can set the time to wait before the
capture happens here (the default is 500 ms), whether or not to include the cursor, and other options such
as the background colors to use for multi-region captures. Auto-scroll is a setting used to capture long
windows such as web page content. (You won't enable auto-scroll for most captures.)

For detailed help on this tab, see the {button Capture tab help
topic,JI("hprsnap4.hip","IDH_capture_tab_example")} section.



T
i@ View & edit tab
This tab controls how HyperSnap-DX 4 handles new images as you make repeated captures. Your
options include replacing the image that's currently in the workspace, pasting each new capture over the
previous (this can create interesting effects), and Do not change current image.

For more help on this tab, see the {button View && Edit tab help,JI("hprsnap4.hlp","idh_view_edit_tab")}
seciton.



T
Kool BW_DLG

/I *** Capture/Capture Settings/View and Edit tab



T
i@ RESIZE

Click on {button Image menu,JI("hprsnap4.hlp","idh_image _menu_help")} to read more about other items
on this menu.



e

Cut

This "cuts" the selected region to the Windows clipboard. You must mark a region with the Select area
tool, it's the dotted box on the Painting tools palette. The area you cut will be "blanked out" with the
background color you define in the Capture tab on the {button Capture settings
tabs,JI("hprsnap4.hlp","IDH_capture_settings_tabs")}, or you can select the color using the background

color selector tool on the bottom of the painting tool palette. The default color for backgrounds, capture "in
between regions" and cut regions is white.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



§isl
Copy
This copies the selected region or the entire file (if no region is selected) to the Windows clipboard.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



e
i@ Paste

This pastes the contents of the Windows clipboard into the current workspace.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



e
i@ Clear

This function "blows away" the current image, leaving you with a blank canvas of the same size, color
dept, and proportions.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



Kl

Undo

This un-does the last operation you performed, if it was a change to an opened image. For example, if
you adjust the color and don't like the result, immediately select this to "go back" to the previous version
prior to the color adjustment.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



§isl

Redo

This re-executes the previously "un-done" operation. You can toggle the state of this and Undo back and
forth to examine the last change you've made to a file as a way of judging if you like the effect.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Magnifying tool
This tool acts just like a magnifying glass. Move it over the image and press the left mouse button to
zoom in, with the area below the glass being the center of the zoomed display. To zoom out, press the

right button. You can zoom back and forth between in and out as you wish.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



Kol

View only
This sets the mode to "view only mode." It means that you're not using the drawing tools, that no tool is
currently selected to act on the image.
Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



§isl
Resize
This function lets you resize (by pixel dimension count) both the horizontal and vertical dimensions of the

image. You can also change the color depth at the same time, if desired, or crop to the current marking
rectangle (if one exists).

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



L=
i@ Select area

This function turns the cursor into an area selection tool. You can mark areas to cut, copy, or relocate. To
select an area, drag the mouse cursor across the image with the left button held down until the area you
want defined is selected. Let up on the button and the area will be marked. "Handles" will appear on the

area that will let you alter the selection after it's marked.

You can alter it by dragging corners in or out (to size the selection diagonally on that corner's axis) or you
can alter just a single side by dragging a side's central button up or down or sideways. To move a
selected area across the image, simply click in the center of the area and drag it to where you want it.
You can't re-size the moved area after it's placed.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Flood fill tool
This function provides an area fill tool, sometimes called a "bucket fill," because it's like dumping a bucket
of paint across the image. It uses the Foreground color selected at the bottom of the tool palette for its fill

property.
Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



L=
i@ Text tool

This function loads a special tool that will let you type text onto your image. First you define an area
where you want the text to reside. This sets the "wrapping boundaries" for what you type. From the dialog
that appears next, you can choose the font from those available on your system, as well as its size and
color (just as with any Word processor).

e
i@ The text you type into the entry box will appear on the image as you type it, giving you a real-time
preview. Set font properties like italics or bold from the box, and click the X button when you're through to
finish.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Spray can tool
This function loads a tool that works like an airbrush or can of spray paint. It uses the color defined on the
foreground drop-down at the bottom of the tool palette. You can change the size of the spray can tool by

selecting a different "tool width" from the pen-width tool drop-down list.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



L=
i@ Arrow tool

This function draws "point to" arrows. These are extremely handy for creating labels on a graphic where
you need to point to specific items on the graphic and then type in explanations. You can control the type
of arrow head (hollow, filled, or architectural) by choosing a different selection from the drop-down list

beside the tool's button. This tool uses the color defined by the foreground picker tool at the bottom of the
palette.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



§isl
Eraser tool
This function allows you to erase parts of the image to the background color defined in the background

color button at the bottom of the painting palette. You can change the size of the erasing tool by selecting
a different "tool width" from the tool width selection drop-down on the bottom of the palette.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Freehand drawing tool
This tool lets you draw on the image using a pencil-like tool. Choose a color from the foreground color

picking tool, and a width from the tool width tool.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Line drawing tool
This tool draws straight lines. To use it, click where you want the line to originate and then drag the tool by
holding the left mouse down until the "rubber band" is at the length and direction you want the line to be.
Let up on the mouse and the line will end at the current cursor location.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Eraser width selector
This tool lets you choose eraser widths from several possible sizes. Choose the desired size and then

click the eraser tool to clear areas of the image using the chosen eraser.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



e
i@ Tool line width selector
This tool changes the widths of all of the painting tools (spray can, line tool, pencil, arrow tool, and so
forth). Choose from the available sizes and the dimensions of the tools that use this value will change

accordingly.
Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Rectangle tool
This function draws "empty" rectangles on the image using the foreground color defined by the
foreground color selector tool. To draw a rectangle, select this tool, choose the color and line width you
wish to use, click at the point on the image you want to use for the origin of the rectangle, and then drag
the mouse cursor by holding down the left button until the rubber band bounding tool shows the rectangle
you wish to draw.

Let up on the left button and the rectangle will be complete.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Rounded rectangle tool
This function draws "empty" rectangles with rounded corners on the image using the foreground color
defined by the foreground color selector tool. To draw a rounded rectangle, select this tool, choose the
color and line width you wish to use, click at the point on the image you want to use for the origin of the
rounded rectangle, and then drag the mouse cursor by holding down the left button until the rubber band
bounding tool shows the rounded rectangle you wish to draw.

Let up on the left button and the rounded rectangle will be complete.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



-y
i@ Ellipse tool

This function draws "empty" ellipses on the image using the foreground color defined by the foreground
color selector tool. To draw a ellipse, select this tool, choose the color and line width you wish to use, click
at the point on the image you want to use for the origin of the ellipse, and then drag the mouse cursor by
holding down the left button until the rubber band bounding tool shows the ellipse you wish to draw.

Let up on the left button and the ellipse will be complete.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Filled rectangle tool
This function draws "filled" rectangles on the image using the foreground color defined by the foreground
color selector tool. To draw a rectangle, select this tool, choose the color and line width you wish to use,
click at the point on the image you want to use for the origin of the rectangle, and then drag the mouse

cursor by holding down the left button until the rubber band bounding tool shows the rectangle you wish
to draw.

Let up on the left button and the rectangle will be complete.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Filled rounded rectangle tool
This function draws "filled" rectangles with rounded corners on the image using the foreground color
defined by the foreground color selector tool. To draw a rounded rectangle, select this tool, choose the
color and line width you wish to use, click at the point on the image you want to use for the origin of the
rounded rectangle, and then drag the mouse cursor by holding down the left button until the rubber band
bounding tool shows the rounded rectangle you wish to draw.

Let up on the left button and the rounded rectangle will be complete.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Filled ellipse tool
This function draws "filled" ellipses on the image using the foreground color defined by the foreground
color selector tool. To draw an ellipse, select this tool, choose the color and line width you wish to use,
click at the point on the image you want to use for the origin of the ellipse, and then drag the mouse

cursor by holding down the left button until the rubber band bounding tool shows the ellipse you wish to
draw.

Let up on the left button and the ellipse will be complete.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Foreground color selector
This drop-down list and selector palette allows you to set the foreground color as used by the various
painting tools. You can also choose an eyedropper tool to pick the color from the image, allowing easy

matching to an existing color. In addition, you can pick from the complete available palette by choosing
the More colors option on the bottom of the drop-down.

e
i@ Like all Windows applications that have access to the More colors function, you can even define
new "custom" colors that are not in the standard supplied system palette and use them, too.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Background color selector.
This drop-down list and selector palette allows you to set the background or "canvas" color as used by the
eraser, cut, and clear functions. You can also choose an eyedropper tool to pick the color from the image,
allowing easy matching to an existing color. You can define transparent colors (for transparent GIF files
used in web design, for example) by choosing a color and then checking the box specifying that).

You can pick from the complete available palette by choosing the More colors option on the bottom of
the drop-down.

L
i@ Like all Windows applications that have access to the More colors function, you can even define
new "custom" colors that are not in the standard supplied system palette and use them, too.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



T
i@ Highlight selector
This lets you choose the color that HyperSnap-DX 4 uses for its highlight functions. You can define a
region that will appear to be seen as filtered "through" the selected color or as if the selected color was
painted over it. You can toggle through the available colors by repeatedly clicking the button, too.

Click on {button Toolbar,JI("hprsnap4.hlp","idh_hypersnap_toolbar")} to read more about the toolbar and
painting tools palette.



Kl

New

Use this function to clear the workspace and start a new file. You'll be prompted to save any changes if
you have an altered image already open.

For more help about the File menu, see the {button File menu
help,JI("hprsnap4.hip","idh_file_menu_help")} section.



e

Open
Use this function to open an existing graphics file. You can navigate throughout your system to locate the
file you wish to open. Also on this dialog is a selector drop-down that will let you "filter" the view you see,
showing you only the files of the desired type you wish, or a "global” filter that will show you many
common graphic file formats.

For more help about the File menu, see the {button File menu

help,JI("hprsnap4.hip","idh_file_menu_help")} section.



e
i@ Close

This closes the currently opened file. If you've changed it and have not saved it, you'll be prompted to do
this.

For more help about the File menu, see the {button File menu
help,JI("hprsnap4.hip","idh_file_menu_help")} section.



§isl

Save

This saves the currently opened file, making your changes (if any) permanent. If you have not previously
saved this file, you will be asked to supply a name for the file.

For more help about the File menu, see the {button File menu
help,JI("hprsnap4.hip","idh_file_menu_help")} section.



e
i@ Save as

This function saves the currently-opened file using a new name. It's a convenient way of saving a project
in "steps" as you modify it. For example, you can apply a color adjustment, select Save as, save itas a
new name, then apply more modifications, and then Save as again, and so forth.

iy
i The save as function offers some important options when you first elect to save your capture or
modified file. One of them is quality and color bit depth settings. For example, a quality setting of 50% for
JPG images is probably fine to e-mail a picture of your Airedale "Sparky" to a friend, but for something
you'll be printing, you'll usually want the maximum quality available, such as 90% or even 100%.
Next is the color bit depth setting. You will probably leave this setting at Keep Current, it will not attempt
to alter the image's bit depth, resulting in maximum quality. If you check the option Select best, it will try
to reduce the file to as small as size as possible without removing any colors that are in use. So if file size
is not an issue, Keep Current is probably the desired setting. If you're attempting to reduce the image's
size to as small as possible but maintain quality, choose Select best.

For more help about the File menu, see the {button File menu
help,JI("hprsnap4.hip","idh_file_menu_help")} section.



Kl

Page setup
From the dialog that appears here, you can define the precise format of pages you wish to print. The
options available here are pretty self-explanatory, and include paper size choices, margin sizes, and
whether or not you want the document printed in Portrait or Landscape format.

There is a real-time preview on the Page setup dialog that gives you a good example of how your
document will look when you print it.

oty
i@ Make some changes on the dialog and see how the preview alters, you'll quickly grasp what each
setting does. You can always cancel them without any problems.

For more help about the File menu, see the {button File menu

help,JI("hprsnap4.hlp","idh_file_menu_help")} section.



Kol

Print

This function prints your current document. How it will look is affected by the options you choose in
{button Page setup,JI("hprsnap4.hlp","idh_page setup")}, so be sure to read through that section as well

as the main help file section that covers the File menu (which you can jump to by clicking the button
below).

For more help about the File menu, see the {button File menu
help,JI("hprsnap4.hip","idh_file_menu_help")} section.



L=
i@ Print direct

This dumps the current image directly to the printer without showing a preview or selection options. It's a
fast way to get a quick printout of the current image. No footers or headers or other information other than
the image itself will appear on the page (or pages).



T
i@ Print preview
This function provides a "what you see is what you get" preview of your current document. The preview
attempts to let you know how---using your page setup and other settings---the document will look when
sent to the default printer.

iy
i If your default printer is a grayscale device, the program will not show a preview in grayscale unless
you have selected to print in grayscale and the device identifies it as such. It will show the image in color
with some adjustments to it to simulate how your device will handle the color image when it prints it.

For more help about the File menu, see the {button File menu
help,JI("hprsnap4.hlp","idh_file_menu_help")} section.



T
i@ Send by Email
This function will attempt to contact your E-mail program and send the file as an attachment. You'll be
required to choose the recipient and set other options from within the E-mail client itself.

e
i{; Note that this function may fail unless you have correctly set up E-mail on your system, and have
set certain default options to allow MAPI enabled programs to access your E-mail client. If this function
fails, try installing and configuring Outlook Express, which ships with most versions of Windows. Users of
other products should determine if their product can be used as a MAPI client, and if so, try enabling this
functionality in order to provide the desired functionality.

For more help about the File menu, see the {button File menu
help,JI("hprsnap4.hlp","idh_file_menu_help")} section.



Kl
Copy
This copies the selected region or the entire file (if no region is selected) to the Windows clipboard.

For more help about the Edit menu, see the {button Edit menu
help,JI("hprsnap4.hip","idh_edit_menu_help")}



e

Cut

This "cuts" the selected region to the Windows clipboard. You must mark a region with the Select area
tool, it's the dotted box on the Painting tools palette. The area you cut will be "blanked out" with the
background color you define in the Capture settings, {button Capture settings
tabs,JI("hprsnap4.hlp","IDH_capture_settings_tabs")}. The default color for cut regions is white.

For more help about the Edit menu, see the {button Edit menu
help,JI("hprsnap4.hlp","idh_edit_menu_help")}



Rl

Paste

This function pastes the contents of the Windows clipboard into HyperSnap-DX 4's workspace. The
contents must be graphical in nature, or the function will be unavailable.

For more help about the Edit menu, see the {button Edit menu
help,JI("hprsnap4.hlp","idh_edit_menu_help")}
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Undo

This un-does the last operation you performed, if it was a change to an opened image. For example, if
you adjust the color and don't like the result, immediately select this to "go back" to the previous version
prior to the color adjustment.

For more help about the Edit menu, see the {button Edit menu
help,JI("hprsnap4.hlp","idh_edit_menu_help")}



§isl

Redo

This re-executes the previously "un-done" operation. You can toggle the state of this and Undo back and
forth to examine the last change you've made to a file as a way of judging if you like the effect.

For more help about the Edit menu, see the {button Edit menu
help,JI("hprsnap4.hlp","idh_edit_menu_help")}



e
i@ About

This menu item shows a credit screen listing the exact version of the program and some Copyright
information.



T
i@ Keep current
Check this so that when you save your document, HyperSnap-DX 4 doesn't alter the current image color
depth (sometimes called color "resolution™).



§isl
1 bit per pixel
Check this to set the color depth of your saved image to 1 bit, which is black and white.



T
i@ 4 bits per pixel
Check this to set the color depth of your saved image to 4 bits, which is 16 colors. This is commonly used
for bitmaps applied in software user interfaces, and other such applications where you need a drastically
limited palette.



T
i@ 8 bits per pixel
Check this to set the color depth of your saved image to 8 bits, which is 256 colors. Most images can
reduce down to this color depth with only a little degradation. Complex images may not reduce down to
this level well, and images with smoothly graded areas, such as wide expanses of sky, may show banding
when reduced to 256 colors.



T
i@ 16 bits per pixel
Check this to set the color depth of your saved image to 16 bits, which is 16,384 colors. Most images will
look very good at this color depth, even complex images with graduated areas.



T
i@ 24 bits per pixel
Check this to set the color depth of your saved image to 24 bits, which is 16 million colors, the standard
for publishing and high-quality graphics. Virtually any image will experience no "loss" of color depth when
saved to this level. In some cases, your Windows video driver many not even support this color depth (but

most modern video drivers do these days).



T
i@ 32 bits per pixel
Check this to set the color depth of your saved image to 32 bits, which is "true color," including a channel
for transparency, which is defined by the color you choose as the background. This is the highest color
depth supported by most paint software (although higher values are possible, the human eye cannot
distinguish between more colors than 32 bit color supports). Files destined for pre-press or artwork

publication are best saved at this value.



T
i@ Select best (color bit depth)
Check this to have HyperSnap-DX 4 examine the image and try to set the color depth to the lowest value
that will attain the highest quality image, but reducing file size if a high depth isn't required for an image.
For example, an image may be 32 bit, but actually only display 200 colors. If so, you could reduce this
down to a much smaller 256 color image without any degradation in the image's appearance.



T
i@ Quality factor
This box represents the amount of "quality" you wish to retain in your image, and is available for formats
that support compression, such as JPG and CMP formats. A value of 100% represents no change in your
image, a value of 50% represents a reduction in "quality" of one half. Read this {button Important note
about quality,PI("hprsnap.hlp”,"hidc_important_quality _note")} before you apply this to any image.



T
i@ Important quality note
If you save a file with, say, 50% quality, then edit it, and then save it again and leave it at 50% quality,
you're gradually "chewing away" at the quality of the image each save. So if you wish to reduce the
quality of the image 50% from the first stage, set quality at 50%, save the image, continue editing, and for
the next save, make sure quality is set to 100% or you will get yet another reduction in quality from the
currently-reduced-by-50% image. Over time you can grind an image into the ground by doing this. The
key is to remember that this is for each save, and each save causes a successive reduction. It's easy to

forget, and the result may be an unusable image



T
i@ Palette - Optimized
Check this to use the optimized palette for your image. On some formats, this isn't applicable, but on
others who use image palettes (such as GIF and BMP) this affects whether or not the image uses the
Windows standard palette, which reserves certain colors, or if the palette is "shifted" to the best possible
location for that image's contents. This option selects the best possible palette of the chosen number of
colors for displaying the image's contents.



T
i@ Palette - Std. Windows
Check this to use the standard Windows palette for the image. This palette reserves certain colors for use
by the system, and makes no attempt to adjust the placement of the palette and the colors on it for "best"
use of the number of colors. If you choose this, some images may shift appearance unpredictably, but for

some applications, this format may be necessary.



T
i@ Quality factor scrollbar
Use this tool to quickly slide the quality factor percentage up and down. Higher numbers mean a better-
looking image (for the most part). Lower numbers mean a smaller image but with possible degradation in
tone, color, and detail.



L=
i@ control group
Click on the ? button and then on an individual tool to read about these controls.



L=
i@ control group
Click on the ? button and then on an individual tool to read about these controls.



L=
i@ control group
Click on the ? button and then on an individual tool to read about these controls.
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i@ Append

Check this to append the current file to the end of a previously-saved file. This is only available for
formats that support multiple images, such as AVI or GIF.



T
i@ Interlaced / Progressive
Check this to save the file in what's called "Progressive" or "Interlaced" formats. This label changes
depending on what file type you select. These image properties are only supported by certain file types,
such as GIF, JPG or CMP formats. This property lets viewers see the file quickly, with more and more
details appearing as the file is rendered. Commonly used for images on web pages, it's generally used
where the file must be viewed over a slow network connection. GIF supports Interlaced, and JPG and

CMP support Progressive.



T
i@ Transparent
Check this to save the file with transparent file properties. This is only available for certain file formats that

support a transparency value within their data structures (like GIF). The color you have chosen as the
background color is the color used for transparent areas.



T
i@ Save options
Click this button to save the current options as the default options. Your preferences for the controls here
will be established in HyperSnap-DX 4's registry.



T
i@ Orientation - Portrait
Check this to set your printout to use Portrait orientation (the most common method, with the narrow
dimension of the paper across the top, and the longest on the sides).



T
i@ Orientation - Landscape
Check this to set your printout to use Landscape orientation (where the paper is printed with the long
dimension on the top, and the short on the side). If you're printing wide images, this is probably the best
to use.



Kol

Best fit

Check this to have HyperSnap-DX 4 analyze the image and make a "best guess" about how the image
will fit on the page. It attempts to maximize the use of the page in respect to the image, and to create a

more aesthetic placement of the image in respect to the dimensions of the page.



T
i@ Header and footer
Click this button to set up header and footer text. The text you specify here is printed on the top, above
the image (header) and on the bottom (footer) below the image on your page.



L=
i@ Font size

Choose the font size you want to use for your headers and footers. The default value is 14.
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Header text

Click in this box and type the text you wish to include in your header. There are values to the right you can
use that will automatically fill in things like the file name, date, and so forth just like macros. These are
handy when you're printing out a book to use as a reference for images stored on a CD-ROM or other

drive, as you can set the header to include the path and filename.
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i@ Justify - left

Click here to left justify your header text.



T
i@ Justify - center
Click here to center your header text.



T
i@ Justify - right
Click here to right justify your header text.
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i@ Footer text

Click in this box and type the text you wish to include in your footer. There are values to the right you can
use that will automatically fill in things like the file name, date, and so forth just like macros. These are
handy when you're printing out a book to use as a reference for images stored on a CD-ROM or other
drive, as you can set the header to include the path and filename.
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i@ Justify - left

Click here to left justify your footer text.



T
i@ Justify - center
Click here to center your footer text.



T
i@ Justify - right
Click here to right justify your footer text.



iiﬁ Help

This loads the main help file topic for this dialog.



e
i@ Cancel

This cancels the operation and discards your changes.
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OK or Done
This closes the dialog and completes the operation.



T
i@ Invert black & white
Check this to have black and white content inverted when you print your image.



T
i@ Black and white only
Check this to have a color image printed in black and white (even to a color printer).



L=
i@ Draw frame

If you check this, HyperSnap-DX 4 will draw a thin box around the perimeter of the image to set it off from
the background. If your image has a lot of white, you may want this to better define where it stops and
where the empty paper begins.
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i@ Fit to page

Checking this causes HyperSnap-DX 4 to "stretch" images that are smaller than the page so that they
take up as much of the paper as possible, within the defined margins and the printable area of the paper.
Depending on how you've decided to print, and aspect ratio of the picture, and other options, this may fill
the entire page, or all the way across it (but not all the way down) and so forth.



e
i@ Scale

Check this to enable image scaling. The image will be scaled (up or down) by the value that you define in
the box on the right. If you scale a very small image drastically upwards, it may begin to degrade and look
"chunky." If you check Auto fit to page, you cannot scale, because the two conflict.
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Scale value
Enter a percentage here if you've enabled image scaling during printing. The meaning of this should be

obvious, with 100% representing the exact image size, 200% representing double, 50% representing 1/2,
and so on. You can scale by one percent increments, all the way down to 1% which will give you almost

nothing at all on the page for most images (a tiny dot, probably).



T
i@ Auto fit if scale too large
If you get too exuberant with your scaling value, HyperSnap-DX 4 will correct your scaling suggestion so
that, at the largest, the image will still fit on the page using the desired printing orientation, paper size, and
margins.



T
i@ Wallpaper filename to use
You can type in the name you want to use for the file you're defining as your Windows wallpaper. The
current image will be saved to this name, in the proper directory, and Windows settings will be changed
so that this image is your current wallpaper. The change will take place at once, with your current

wallpaper removed and the new file displayed in its place.



il
Q Browse

Click this to browse to select a wallpaper file to use as the name of your wallpaper.



e
i@ Center

Click here to have the selected wallpaper file set to be viewed as "centered" on your desktop.
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Tile
Click here to have the selected wallpaper file to be viewed tiled across your desktop. If the image is much

smaller then your screen resolution, tiling will make sure it covers the desktop. In some cases, you might
make a very small image actually like a tile in order to achieve a repeating pattern created by the tiling

process.



L=
i@ Stretch

Click here to have the selected wallpaper file to be stretched so that it fills the desktop without tiling. If the
image is only slightly smaller than the desktop, it can almost always be displayed in this way without
seriously degrading it. A very tiny image will often get distorted during this process, but most images that
are close to the size of your desktop will stretch just fine.



T
i@ Remove wallpaper
Click this button to remove the wallpaper and clear the setting. Windows will display the color you've set
your desktop to be instead of the bitmapped image it had been displaying.
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i@ Send as format selector
Choose from supported formats to use for the file you wish to send.



L=
i@ Sub-format

Select the sub-format properties for the desired file type. These include whether or not the file is
compressed, and by what method, and other properties depending on what file type you choose from the
top selector drop-down.



T
i@ File name to send
Type in the file name you want to use for your e-mail attachment (without a path or extension, which will

be handled by HyperSnap-DX 4). If you don't pick a name, the program will assign one for you
automatically.



T
i@ Enable DirectX/Direct3D capture
Check this to enable captures from this type of display technology. If you're not sure what your game or
software is using, you can check more than one capture type.



T
i@ Enable overlay capture
Check this to enable captures from special DirectX, Direct3D overlay technology (common for DVD

players and other software that shows special content within a window). If you're not sure what your game
of software is using, you can check more than one capture type.



e
i@ Enable 3dfx Glide capture
Check this to enable captures from 3dfx boards (such as Voodoo, Voodoo Rush, and later boards).



T
i@ Advanced overlay control
Click this button to open the controls for setting options related to handling advanced overlay capture
types. These captures can be "tricky" and may require a bit of finessing by changing the options in the
next tab.



T
i@ Auto detect
Check this to have HyperSnap-DX 4 attempt to auto-detect what format of image your overlay capture will
need to use. You may have to try manual settings if captures using Auto detect fail to obtain an accurate

picture.



T
i@ YV12 format
Check this to have the program interpret the data from the device in the specified format.



Check this to have the program interpret the data from the device in the specified format.



T
i@ YUY2

Check this to have the program interpret the data from the device in the specified format.
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i@ IYUV/1420

Check this to have the program interpret the data from the device in the specified format.



iiﬁ YVYU

Check this to have the program interpret the data from the device in the specified format.



T
i@ Enable post processing of pictures...
Check this to set HyperSnap-DX 4 to post-process pictures captured from 3D acceleration hardware.
Such captures can often require some adjustments to look "their best," and this special handling is built
into the program. This includes certain types of filtering applied to the images these special hardware
devices generate in order to make them look better than a "naked" image right from their hardware
buffers.



T
i@ Filter selection group
This group of controls contains the filters from which you can choose to use in post processing of DirectX

or Glide captures. Click on the ? and then on the individual controls to see brief help about the three
options in this group.
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i@ None, unknown, or other...
This tells HyperSnap-DX 4 not to apply any filters to the data, that you have none of the specified cards
listed in the filter group.



T
i@ 1x4 filter for 3dfx Voodoo 1...
Check this to have HyperSnap-DX 4 apply a 1 x 4 filter to data captured from early Voodoo cards. This
filter improves the appearance of images grabbed from such hardware (in most cases).
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i@ 2x2 filter for 3dfx Voodoo 2...
Check this to have HyperSnap-DX 4 apply a 2 x 2 filter to data captured from later Voodoo cards based

on the number 2 or number 3 chipset. This filter generally improves the appearance of images grabbed
from such hardware (in most cases).



T
i@ Gamma correction factor
Here you can define a gamma correction factor to the capture. Many 3D controller cards produce dark
images. You can save a step by having the image automatically "punched up" during capture.



T
i@ Set default gamma
Click this button to set the specified value as the default gamma value for captures from 3D hardware.
The next time you perform this type of capture, the image will be adjusted to the value specified here.



T
i@ Delay time before the capture
You can specify the time in milliseconds (1000 milliseconds is 1 second) that the program will wait before
executing the desired capture.



T
i@ Include cursor image
Check this to have HyperSnap-DX 4 include the mouse cursor in the capture.



T
i@ Auto-scroll window...
This powerful function can scroll a long window and actually include regions out of view (such as a long

web page) in a single image. Not all programs are compatible with this feature, and if you find the function
does not appear to work, the client application is likely causing a problem with HyperSnap-DX 4's "place
markers." Currently IE 5 and Netscape 4X are known to work with this feature, other browsers or

programs may not.



T
i@ Auto-scroll refresh time
This is the time in milliseconds (1000 milliseconds is 1 second) between window refresh operations used

during auto-scroll. HyperSnap-DX 4 will refresh its window at the rate specified here. You can use this to
control how fast it shows you what it's capturing, which will let you watch the capture and (for example)

stop a capture when it's gone as far as you need.



T
i@ Show help and zoom area...
By default HyperSnap-DX 4 shows some help when you begin a region capture. Once you've got the
"hang" of region captures, you can disable the help text by clearing this box.



T
i@ Default region shape
You can choose from a list the region shape you want to use for region captures. Drop down the list to
see the available choices. If you choose a non rectilinear shape, HyperSnap-DX 4 will fill the area
"around" the captured data with the background color you select on this tab in order to create a rectilinear
image.



T
i@ Start multi-region capture with...
You can start multi-region captures with either a Window/control selector or a region capture. (After the

first region, you can change to the other type as you wish by hitting the appropriate hot key for that type of
capture and continuing).



T
i@ Play sound...

Checking this causes HyperSnap-DX 4 to play its trademark camera shutter sound when you execute a
capture. If you'd like silent captures, clear this box.



T
i@ Restore HyperSnap window...
Check this to have the program's window automatically come back to the front after a capture so you can
examine the results.



T
i@ Crop image checkbox
Check this to enable automatic cropping of captures using the values defined by the boxes in this group

of controls. If you're repeatedly cropping your captures (and always by the same amount) this can save
some time.



L=
i@ From left

Define a value in pixels to crop from the left margin. For example, a value of 20 will discard the image
from 0-19 pixels, and the data you retain will begin at pixel 20.



Kl

Top
Define a value in pixels to crop from the top margin. For example, a value of 20 will discard the image
from 0-19 pixels starting at the top. The data you retain will begin at a pixel count 20 down from the top.



T
i@ Width

Define a value in width (total) to use for the image. Default value is your screen resolution.
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Height
Define a height value (total from top to bottom) to use for the image. Default value is your screen
resolution.



T
i@ Set to current selection rectangle
Click this button to set your crop image parameters at the size of the current selection rectangle (there
must be one, of course, defined on the image in HyperSnap-DX 4's workspace. This makes crop setup
extremely easy, simply capture the image size you wish to use, mark the crop you want to use from now

on, and click this button.



T
i@ Scale image checkbox
Check this to enable automatic image scaling of your captured data. This allows you to do many captures

and automatically re-scale them to fit exact specifications rather than having to do this manually. Use the
values in the data entry boxes of this group to set up scaling.
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Width

Set the scaling width, in pixels or percentage of original image size that you want to use as the scaling
size. You can scale your original captures (which may be any size) to this specific width. Note that if the

width and height aspect ratio aren't linked, the image will become distorted.



T
i@ in pixels

Check this to define your scaling to be in pixels (versus percentage of original).
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scale factor
Check this to define your scaling to be in percentage of the original (versus pixel count).
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Height
Set the scaling height, in pixels or percentage of original image size that you want to use as the scaling
size. You can scale your original captures (which may be any size) to this specific width. Note that if the

width and height aspect ration aren't linked, the image will become distorted.



T
i@ in pixels

Check this to define your scaling to be in pixels (versus percentage of original).



§isl
scale factor
Check this to define your scaling to be in percentage of the original (versus pixel count).



T
i@ Keep aspect
Check this to link the aspect ratio of both width and height, to keep the image from becoming distorted. If
you don't link the values, and select different ratios for the two dimensions, the image may become
"squeezed" or "stretched."



T
i@ Interpolate colors
Check this to set the program to smooth out scaling (especially "upward") by interpolating the pixels
between areas. This should improve the appearance of drastically scaled images.



T
i@ Replace the image...
Check this to have HyperSnap-DX 4 replace the image currently in its workspace with any new capture
you execute.



T
i@ Paste each new capture...
Check this to paste each new capture onto the current image. This allows you to collect a series of
smaller captures in a larger image almost as an "album" format. The new data is highlighted as an object
and can be relocated until you click elsewhere on the workspace or perform another operation. Once
you've clicked (or done another capture) the previous data is "glued" to the base image.



T
i@ Do not change...
Check this if you want HyperSnap-DX 4 to leave the workspace alone, and put captures on the clipboard

(or print them) based on settings in the other tabs, Copy and Print or Quick Save. This allows you to work
on an image, but perform a new capture, and have both available.



T
i@ Copy each capture to clipboard
Check this to instruct the program to also send its captures to the Windows clipboard. Note that if you've
also set it on the Capture tab to control the standard clipboard functions, it will be doing this even if this
box isn't checked. But if you've left the previous option un-checked, checking this will cause it to insert the
image into the clipboard in addition to HyperSnap-DX 4's workspace.



T
i@ Paste each capture to...
Check this to have captures automatically pasted to a running application after it's put onto the system
clipboard.



T
i@ Paste capture to application name
From the list of running programs, choose the one to which you wish to send the capture. HyperSnap-DX
4 will attempt to use a DDE link to send the image through the clipboard and to this program. It must be
running at the time you capture (don't close it after setting it here) and it must accept graphics data of the
size and format you've defined in other HyperSnap-DX 4 options.



T
i@ Minimize this window before the capture
Check this to have HyperSnap-DX 4 minimize itself automatically before you begin your captures.



T
i@ Automatically print each capture
Check this to have the program send each capture to the default printer listed in your printers folder.
Make sure that this is the printer you wish to use for the type of data you will be capturing.



T
i@ Automatically save each capture
Check this to save each capture automatically to a file. This lets you quickly collect images of a game in

progress, or the status of a program operating over time, even without having to stop to specify each
filename to use.



T
i@ Prompt for name on each capture
Check this to have the program ask for a file name after each capture. After specifying a name, you can
continue with more captures, simply specifying a name after each one.



T
i@ Auto save filename
Specify the filename to use as the "root" filename when auto-saving files. Used especially when you

disable the prompt for name function, above, as the program can automatically increment this name as
you proceed with more captures.
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i@ Change

Click this to pick another file name to use for auto-saved files. You can specify the exact format to use for
the file, too, including color depth and sub-format specifications.



T
i@ Increment file name...
Check this to automatically increment the auto-save file name. This allows you to save many images all
with the same "root" name. Useful for grabbing many images of a procedure or gameplay.



T
i@ Starting number
Pick a number to start at for the auto-increment name. It should obviously be less than the stop at
number!
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i@ Stop number

Pick a number to stop incrementing at. If you've also checked the Loop function (to the left) the captures
will go to this number, then begin back at the starting number, overwriting previous captures of the same

names.



T
i@ Loop from 1 to "stop" number...
Check this to set the program to use the numbers in Start and Stop over and over as you repeat captures.

This can prevent you from filling your entire hard disk with captures. Previous captures of the same
names will be overwritten as the program re-uses the names within the group specified.



T
i@ Repeat first capture every
Enter a value here in seconds to set the program to grab captures of the specified type you first make
once you've closed the dialogs every X seconds. For example, if you want to capture the same window
every 20 seconds, set the value here to 20, OK out of the dialog, hit the hot key for a window capture,
select the window, and the capture of that window will be repeated very 20 seconds. You can use
decimals (such as .5) to capture within fractions of a second.

Combined with the automatic incrementing of files, this lets you capture complex program behavior
without "worrying" about the next capture. It will just happen at the time you specify. To stop it, press the
default "stop auto-capture" hot key Shift+F11.



Ria)
G Continue on error
If you check this, the program will continue capturing even if a minor error occurs.



T
i@ Horizontal resolution
Define the default horizontal resolution of your captures in DPIl. Most SVGA screens are 96 DPI. If you
find yourself repeatedly setting this value up (or down) after captures to fit the work you're doing, change
the default here to save some steps. The default is your current video driver resolution.



T
i@ Vertical resolution
Define the default vertical resolution of your captures in DPI. Most SVGA captures are 96 DPI. If you find

yourself repeatedly setting this value up (or down) after captures to fit the work you're doing, change the
default here to save some steps. These two values should match, and if they do not, your images may not
appear (or print) correctly. The default is your current video driver resolution.



T
i@ Apply to the current image
Check this to apply the change here to the capture or image currently open in HyperSnap-DX 4's
workspace. It (and future) captures will be set to the values you specify here.



T
i@ Use as default for future images...
Check this to use the value here for future images captured from the screen. This way if your screen runs
in a DPI higher than your target for captures (for example, a very high SVGA screen but you need
captures at 72 DPI, you can set the values to 72 and then check this box).



T
i@ Percent slider tool
Drag this tool left and right to quickly control the scaling tool percentage of original size value.



T
i@ Percent of original size
Define a percentage of original image value here to use when scaling the image. The default is 100% or
no change. This value will effect a change in the pixel values, below, as you change it. You can alternately
change the pixel values to effect changes here, the controls are linked to represent their relationship.



T
i@ Width, in pixels
Define a pixel width size to use for the image. This is linked to the height if you've checked Keep aspect,
below.



T
i@ Height, in pixels
Define a pixel height size to use for the image. This is linked to the width if you've checked Keep aspect,
below.



T
i@ Keep aspect
Check this to keep the image from becoming stretched or squeezed as you change the dimensions. It will
link the horizontal to the vertical, so changes to one are reflected in the other. If you want to distort an
image, or don't care if distortion happens from aspect ratio alterations, you should uncheck this.
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i@ Interpolate

Check this to set the program to smooth out scaling (especially "upward") by interpolating the pixels
between areas. This should improve the appearance of drastically scaled images.



e
i@ Revert

Click on this button to discard your change and revert the image back to the original settings.
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1 bit per pixel
Check this to set the color resolution to 1 bit per pixel, which is black and white.



T
i@4 bits per pixel
Check this to set the color depth of your saved image to 4 bits, which is 16 colors. This is commonly used
for bitmaps applied in software user interfaces, and other such applications where you need a drastically
limited palette.



T
EQS bits per pixel
Check this to set the color resolution to 8 bits per pixel, which is 256 colors.



T
i@m bits per pixel
Check this to set the color depth of your saved image to 16 bits, which is 16,384 colors. Most images will
look very good at this color depth, even complex images with graduated areas.



T
i@24 bits per pixel
Check this to set the color depth of your saved image to 24 bits, which is 16 million colors, the standard
for publishing and high-quality graphics. Virtually any image will experience no "loss" of color depth when
saved to this level. In some cases, your Windows video driver many not even support this color depth (but

most modern video drivers do these days).



T
i@ 32 bits per pixel
Check this to set the color depth of your saved image to 32 bits, which is "true color," including a channel
for transparency. This is the highest color depth supported by most paint software (although higher values
are possible, the human eye cannot distinguish between more colors than 32 bit color supports). Files

destined for pre-press or artwork publication are best saved at this value.



T
i@ Optimized palette
Check this to use the optimized palette for your image. On some formats, this isn't applicable, but on
others who use image palettes (such as GIF and BMP) this affects whether or not the image uses the
Windows standard palette, which reserves certain colors, or if the palette is "shifted" to the best possible
location for that image's contents. This option selects the best possible palette of the chosen number of
colors for displaying the image's contents. This option is only available for images set to bits per pixel
values below 16 bit.



T
i@ Standard Windows palette
Check this to use the standard Windows palette for the image. This palette reserves certain colors for use
by the system, and makes no attempt to adjust the placement of the palette and the colors on it for "best"
use of the number of colors. If you choose this, some images may shift appearance unpredictably, but for
some applications, this format may be necessary. This option is only available for images set to bits per

pixel values below 16 bit.



T
i@ Netscape safe palette
Check this to save the file using a Netscape browser "safe" palette. This is used if the destination for your
file will be a web page. Netscape uses a certain palette, and if you do not save your images destined for
use within Netscape browsers with this palette, they may not display correctly. You can try saving with
another palette and in a file format Netscape can open, and then previewing the file in Netscape to see if
the file degrades upon loading in the browser. If so, switching to this palette should fix it. This option is
only available for images set to bits per pixel values below 16 bit.



T
i@ Black & white
Saves the file with only a black and white palette. Colors will be mapped to black and white, and the

program will attempt to substitute the light and dark regions for either black or white. Most color images
will degrade when this is selected. This option only becomes available if you select a color bit per pixel

value below 16 bit.



T
i@ No dithering
Check this to "block up" the colors if you are shifting an image downward from high color depths to a
depth below the original value. Dithering can often make an image more recognizable, but it also removes
some detail in order to attempt to create the appearance of colors not really in the image. (It's similar to
how a newspaper photograph is created on the page.) Changes to dithering appear in real-time on your
image, so click through the available selections and examine your image to see which does the best job.
Certain images types will appear better using differing dithering methods.



T
i@ Floyd Stein dithering
Check this to use the named dithering method when reducing colors. This method uses very fine groups
of dots to approximate the missing colors. It's good for most images where a random pattern of dots is not
undesirable. Changes to dithering appear in real-time on your image, so click through the available
selections and examine your image to see which does the best job. Certain images types will appear

better using differing dithering methods.



T
i@ Stucki dithering
Check this to use the named dithering method when reducing colors. This method uses a slightly more
coarse pattern, and highlight areas may begin to look "dotty." Changes to dithering appear in real-time on
your image, so click through the available selections and examine your image to see which does the best
job. Certain images types will appear better using differing dithering methods.



T
i@ Burkes dithering
Check this to use the named dithering method when reducing colors. This method uses a moderately
coarse pattern, and in some cases highlight areas may begin to look "dotty," but it may appear better on
some images that have dark content. Changes to dithering appear in real-time on your image, so click
through the available selections and examine your image to see which does the best job. Certain images
types will appear better using differing dithering methods.



T
i@ Sierra dithering
Check this to use the named dithering method when reducing colors. This method uses a moderately
coarse pattern, and in some images you'll begin to notice the dots, "lining up" where the image displays
"contoured" data. Smoothly graduated areas on the image are coarsened somewhat, also. Changes to
dithering appear in real-time on your image, so click through the available selections and examine your
image to see which does the best job. Certain images types will appear better using differing dithering
methods.



T
i@ Stevenson Arce dithering
Check this to use the named dithering method when reducing colors. This method uses a coarse pattern,

and highlight areas will show definite and strong dot patterns. Broadly graduated areas may appear to be
more clearly delineated, too. Changes to dithering appear in real-time on your image, so click through the
available selections and examine your image to see which does the best job. Certain images types will

appear better using differing dithering methods.



T
i@ Jarvis dithering
Check this to use the named dithering method when reducing colors. This method uses a fairly fine
pattern, and appears to handle highlight areas fairly well. Darker regions may become "dotty" or appear
washed-out. Changes to dithering appear in real-time on your image, so click through the available
selections and examine your image to see which does the best job. Certain images types will appear

better using differing dithering methods.



T
i@ Ordered dithering
Check this to use ordered dithering. This is very close to what is used by a magazine "screening" process
in appearance, and may provide very good results for some images. The image may appear to take on a
"cartoon-y" look, with a horizontal line pattern appearing on some content. However it avoids the "dotted"
appearance of other methods. For images with shallow color ranges (mostly the same colors) this method
should work very well. Changes to dithering appear in real-time on your image, so click through the
available selections and examine your image to see which does the best job. Certain images types will
appear better using differing dithering methods.



T
i@ Conversion slider
Drag this slider back and forth to adjust how your image will be converted to black and white. This
"centers" the black level, and moving the slider may make a color image at least "usable" in black and
white. The result of conversion without dithering (using the color resolution function) may appear almost
like an old woodcut.
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i@ Black level

You can enter a value here, between 0 and 100, for the black level of the image. You can also drag the
slider above this box to control this number. The image is changed in real-time, so you can view how you

image will look before closing this box. The slider is probably the best method to use, unless you wish to
set a group of files to the same black level for some reason.



e
Kol Apply

Click on this button to apply the current setting to your image. This will give you a preview of the number
you've entered. If you use the slider, above, you will get a real-time preview without clicking this button.



T
i@ Capture full screen hot key
Click this button to change the hot key for the described capture method. Make sure the key you choose
does not conflict with other applications or Windows itself.



T
i@ Capture virtual desktop hot key
Click this button to change the hot key for the described capture method.



T
i@ Capture window hot key
Click this button to change the hot key for the described capture method.



T
i@ Capture region hot key
Click this button to change the hot key for the described capture method.



T
i@ Capture active window hot key
Click this button to change the hot key for the described capture method.



T
i@ Capture active window without frame hot key
Click this button to change the hot key for the described capture method.



T
i@ Multi-region capture hot key
Click this button to change the hot key for the described capture method.



T
i@ Pan last region capture hot key
Click this button to change the hot key for the described capture method.



T
i@ Repeat last capture hot key
Click this button to change the hot key for the described capture method.
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i@ Stop auto-capture hot key
Click this button to change the hot key for stopping automated capture sequences.



T
i@ Special capture hot key
Click this button to change the hot key for the described "special" capture method. You will probably have
to use the default Scroll lock key for this function, as may DirectX and Direct3D games (because of the
way they work) trap the other keystrokes and reserve them. Experiment with different hot key settings if
you find that the one you want to use does not work. The default should work with almost all software,
though.



T
i@ Handle Print screen key
Check this to have HyperSnap-DX 4 "capture" the functionality of the Windows print screen key. Instead

of this key being used by Windows, when you press this (if HyperSnap-DX 4 is running) HyperSnap-DX 4
will intercept it and handle the screen capture. This allows you to get greater power and flexibility with this
default function, since HyperSnap-DX 4's features for capturing are much greater than those provided by

Windows.



§isl
Defaults
Click this to reset all of the hot keys to the default values. If you've encountered problems with hot keys

you've changed, or simply want to "start over" and try another set of hot keys, this button will discard your
changes and re-set the key panel.



e
i@ Revert

Click this to revert back to the previous setting, which is that to which the dialog was set when you
opened it. If you accidentally change a key, or decide you want to keep a previously-customized value,
this button will do it.



T
i@ Activate hot keys
Check this to enable HyperSnap-DX 4's hot key functions. If you disable them (clear this box) you will
have to use the menu or mouse to perform hot keys. Should a hot key conflict with a program you need to
run (or capture, for that matter), clearing this will let you capture it with the mouse or menu. You can then
close the offending program and re-enable this box, making captures easier.



T
i@ Auto-start with windows
Check this to have HyperSnap-DX 4 add itself to the list of programs that load when Windows boots. If
you use the program a lot, this can save you a bit of time. If you only rarely use it, and you run Windows
9x, you may want to leave this checkbox cleared to conserve system resources, and load it only when

you need it.



T
i@ Always start minimized
Check this to have HyperSnap-DX 4 start in "iconic" mode rather than showing a window. In addition, if
you've got the program to display a tray icon rather than a taskbar icon, this sets the program to load into
the system tray only, ready for use, but not obtrusive.



T
i@ Display tray icon only...
Check this to have HyperSnap-DX 4 "move" its icon to the Windows system tray. (The system tray is

where the clock is located on the taskbar.) This makes the program less obtrusive, but always ready for
use. Remember, if you enable this, to bring the program up for use, you right-click its system tray icon.



L=
i@ Do not exit...

Check this to set HyperSnap-DX 4 to stay in the system tray when you click its main window's X button.
Otherwise, the program will completely exit when you click this button. This allows you to "get rid of" the
main window by using the X without closing the program. That way it's always ready for use in your
system tray (the area by the clock in the Windows task bar).



iiﬁ Help

Loads the main help file covering the current functions or dialog.



T
i@ Center image
Check this to have HyperSnap-DX 4 center the image on the page.
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i@ Clear all

Click this to clear all the hotkeys to "no values." This allows you to set the keys all from "scratch" without
conflicts between existing key settings and the new ones you wish to use.
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EQCIose

Click this to close the dialog and effect your changes.



T
i@ Background color
Select the color to use for new file backgrounds, and the areas around multi-region or non-rectilinear
captures. You can change this color on the painting tools, also.



T
i@ Enable preview
Check this to examine a small preview display of the currently-highlighted image. The image will appear
in the window displayed on the right-hand-side of the customized Open picture dialog.



T
i@ Page number to open
You can specify here how many pages (images) to open. This allows you to open multiple images (which
will appear in multiple instances of HyperSnap-DX 4).



T
i@ Bitmap dimension - width
Enter the width (in pixels) that you wish to use for your bitmap when you resize it.



T
i@ Bitmap dimension - height
Enter the height (in pixels) that you wish to use for your bitmap when you resize it.



T
i@ Bitmap color depth selector
You can choose a color depth to use when altering your bitmap.



T
i@ Crop to selection rectangle
Check this if you have defined a selection rectangle on your image, and wish to use this as the cropping
guide. The area outside of the selection will be "cut away," leaving only the material on the inside of the

cropping line.



T
i@ Arrowhead length in pixels
You can choose how long you want the arrowhead to appear, in pixels. The change you enter here will be
reflected immediately in the arrow "preview" window, below.



T
i@ Arrowhead width in pixels
You can choose how wide you want the arrowhead to appear, in pixels. The change you enter here will be
reflected immediately in the arrow "preview" window, below.



T
i@ Place arrowheads at end...
Check this to place the arrowheads at the end of drawn lines, adding to their total length. If you uncheck
this, the arrowhead begins back from the line and its point terminates at the end of the drawn line.



T
i@ Font/color button
Click this to choose a font to use within the text tool. From the dialog that appears you can set font size,
face, color, and other properties.



T
i@ Align text left
Click this to align the text you enter on the left margin.



T
i@ Align text center
Click on this to center the text you enter.



T
i@ Align text right
Click on this to align your text on the right margin.
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i@ Bold text button
Click this to set the text you enter to bold. You can also choose the other two properties to combine them
(bold, italics, bold underline, etc.).
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i@ Italics text button
Click this to set the text you enter to italics. You can choose the other two properties to combine them, if
you wish.



T
i@ Underline text button
Click this to set the text you enter to be underlined. The entire line is underlined, including spaces. You
can choose the other two properties to combine them, too.



T
i@ Preview window
This window previews the text as it will appear in your image. Type the text you wish to be inserted into
the image here, and it will be formatted based on your selections for font, formatting, and alignment. Note
that you can re-size the preview window to better fit the text on the screen. If you move the preview
window so you can see your image, you'll be able to preview your typing in real-time, including changes
you make to font properties. Close the text tool box when you're done to make your entry and all font
property settings permanent.



T
i@ Preview window
This window previews the text as it will appear in your image. Type the text you wish to be inserted into
the image here, and it will be formatted based on your selections for font, formatting, and alignment. Note
that you can re-size the preview window to better fit the text on the screen. If you move the preview
window so you can see your image, you'll be able to preview your typing in real-time, including changes
you make to font properties. Close the text tool box when you're done to make your entry and all font
property settings permanent.



T
i@ Preview window
This window previews the text as it will appear in your image. Type the text you wish to be inserted into
the image here, and it will be formatted based on your selections for font, formatting, and alignment. Note
that you can re-size the preview window to better fit the text on the screen. If you move the preview
window so you can see your image, you'll be able to preview your typing in real-time, including changes
you make to font properties. Close the text tool box when you're done to make your entry and all font
property settings permanent.



T
i@ Solid background
Check this to have the text placed on a solid background.



e
i@ Frame

Check this to have the text appear surrounded by a frame.



T
i@ Activate hot keys button (or menu item)
This button displays the status of hot keys for the current (active) instance of the program. Because it
supports multiple instances, only one of these can provide hot key functions.

The status of the toolbar button for this (down for active, up for inactive) or the menu item on the Options
menu (checked or un-checked) tells you if the instance you're examining is supporting hot key functions.

You can "switch" the current instance to the one supporting hot keys by depressing this button or by
checking the Activate hot keys menu item under the Options menu. Once either of these is done, any
previous instance of HyperSnap-DX 4 will "lose" its hot key functions as "hot key focus" is transferred to
the current instance.






